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Abstract
Carbon stored in harvested wood products is recognized under international carbon 
accounting protocols, and some crediting systems may permit the inclusion of 
harvested wood products when calculating carbon sequestration. For managers 
and landowners, however, estimating carbon stored in harvested wood products 
may be difficult. PRESTO (PRoduct EStimation Tool Online) is a Web-based tool 
that enables users to easily estimate the carbon stored in harvested wood products 
and the changes in this quantity over time. The tool may be used in an exploratory 
mode to examine the impacts of changing the amounts of longer- and shorter-lived 
products, or with specific harvest data to produce stand-level reports. The methods 
used are consistent with the Intergovernmental Panel on Climate Change (IPCC) 
Good Practice Guidance, as well as U.S. voluntary carbon accounting guidelines.
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IntroductIon

Forest carbon is stored in harvested wood products. Although some carbon credit trading systems 
may give credit for this carbon, estimating the size of this carbon pool is often cumbersome, especially 
for small landowners. Many forest carbon calculators do not include the harvested wood products 
category, and managers must use coefficients and spreadsheets to estimate the carbon in wood 
products over time. The task becomes complicated when multiple stands or sequential partial harvests 
are involved. PRESTO (PRoduct EStimation Tool Online)is a Web-based tool to help land managers 
and landowners estimate the amount of carbon stored in products over time, based on harvest 
volume, geographic region, and wood type.1 PRESTO can also be used in an “easy” mode, where 
detailed harvest volumes are not required, allowing landowners to estimate the effects of shifting 
the relative amounts of pulpwood and sawtimber harvested. Reports are available in two formats: 
a detailed report providing carbon estimates every 10 years for a 100-year period, or as a 100-year 
average value.

ApplIcAtIon requIrements

PRESTO is an online tool for calculating the amount of carbon stored in harvested wood. It is linked 
to a database located on a remote server. To use PRESTO you must have:

•	 An active Internet connection and

•	 A PRESTO account (log in at http://presto.essa.com).

To request an account, go to the PRESTO login page and click on New user?; complete and submit 
the New User Registration form.

If you wish to upload multiple stands in batch mode, or export your results, you will also need:

•	 Microsoft Access® (2003 or later)—required to upload data about multiple stands using the 
Upload Batch feature.

•	 Microsoft Excel® (2003 or later)—required to copy information for multiple stands into the 
Access template for batch uploads, and required to export the results of carbon calculations 
from PRESTO for further analysis.

1 PRESTO is applicable for forests in the conterminous United States only.

http://presto.essa.com
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USER INTERFACE

Home Page

When you log in, PRESTO will open to its Home page (Fig. 1), which contains a brief description of 
the tool and a menu bar with a series of tabs that access all features and functions of the PRESTO Wood 
Calculator. More information about the development of PRESTO is provided on the Background tab.

At present, you can enter information about a new stand, upload information about multiple stands 
from an Access template file, calculate the amount of carbon stored for each of the harvested stands 
you have entered, export calculations to an Excel spreadsheet, and review summary information about 
all of the stands you have entered and for which calculations have been made.

Figure 1.—Screen capture of PRESTO home page (as of October 23, 2014).

From a development perspective, the tool is flexible. Any number of new tabs can be added to the 
interface to provide additional functionality as needed.

The header information on the Home page is visible on any page in PRESTO. At the top right of the 
header, there are four options: Home, Help, Report a Problem, and Logout. Click on Home from 
any page (other than the Home page) to return to the Home page. You can also return to the Home 
page by clicking on the tree icon in the upper left corner of the header. On the Help page, click on 
the URL to access this PRESTO user guide, and use the email address provided to submit questions 
about PRESTO to technical support. Click on Report a Problem to access the PRESTO Bug 
Reporter form. Complete the required fields on this form to describe and submit to the support team 
the error you encountered while using PRESTO. Click on Logout to exit PRESTO.

Your feedback on current and potential future features of the PRESTO Wood Calculator would be 
greatly appreciated. Use the email address provided on the Home page to send us your comments.
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New Stand

Clicking on the New Stand tab opens a Stand Details page (Fig. 2). Use the fields on this page to 
enter information about the harvest in your stand. The Notes field is optional. All other fields on this 
form must be filled in. If you have information about many stands to enter, you can use the Upload 
Batch option.

Entering Stand Details
The fields and options on the Stand Details page are:

Name Enter an informative name for the harvested stand (for example, a stand identifier 
number or a descriptive name). This is a free-form text field (accepts any character) 
that can accommodate a maximum of 50 characters.

Region Open the drop-down list and select the region in which your stand is located. The 
map beside the field boxes shows the location for each region.

Notes Enter information about the stand. This is a free-form text field (accepts any 
character) that can accommodate a maximum of 255 characters.

Area/Units Enter a numerical value (without commas) to indicate the size of the stand, and 
select the appropriate units (Acres or Ha) from the drop-down list on the right.

Calculate By Select the calculation method (Lump sum or Wood type) you wish to use from 
the drop-down list. For calculation by Lump sum, you need to know the relative 
proportion of sawlogs and pulpwood in the total harvest. For calculation by Wood 
type, you need to know the actual volumes harvested for sawlogs and pulpwood.

Figure 2.—Screen capture of Stand Details entry page, used to enter information on a single stand. To add multiple 
stands at once, use the Batch Upload process. The Notes field is optional and can be used to record information 
about the stand if desired. Choose Lump sum data entry to explore the effects of different levels of sawtimber and 
pulpwood harvest; use the Wood type entry when data on specific harvest amounts are available.
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After you have selected a calculation option, PRESTO will automatically refresh the page and display 
the rest of the fields you need to fill. Do not click on the Save button at this point. If PRESTO 
throws an error, you will need to log out and log back in to clear it.

Calculating Carbon Storage
The calculation method you choose determines what additional information is required to complete 
the requested calculation.

To calculate by Lump sum:

1. If applicable, enter the total volume of Hardwood harvested, and select the appropriate units 
from the drop-down list at right.

2. If applicable, specify the percentage of the hardwood harvest destined for Sawlogs and the 
proportion destined for Pulpwood. These two values must sum to 100 percent, as in the 
example below (Fig. 3).

Figure 3.—Screen capture of Lump sum data entry form.

3. If applicable, repeat steps 1 and 2 for the Softwood component of the harvest.

4. When done, click on the Save button at the top of the page. PRESTO will perform the 
requested calculation and display the results.
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To calculate by Wood type:

1. If applicable, specify the actual volumes of Hardwood harvested as Sawlogs and as 
Pulpwood, and select the appropriate units for each from the drop-down lists at right (Fig. 4).

2. If applicable, repeat the first step for the Softwood component of the harvest.

Figure 4.—Screen capture of Wood type data entry form.

3. When done, click on the Save button at the top of the page. PRESTO will perform the 
requested calculation and display the results.

Viewing Results
The results of PRESTO’s calculations are displayed on a refresh of the Stand Details page, along 
with a summary of the stand and harvest information you entered. The example below (Fig. 5) shows 
calculations by Wood type.

Figure 5.—Screen capture of Wood type calculation results showing the 100-year and 
average values for each harvested carbon pool.
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All results are expressed in tonnes per hectare. Values for total carbon in storage after 100 years 
(C100) and values for annual average amount of carbon in storage (CAvg) are provided for five storage 
categories:

Products End-use products that have not been discarded or otherwise destroyed, such as 
construction products, containers, and paper products.

Landfill Discarded wood and paper products in landfills.
Stored The sum of Products and Landfill.
EnergyCapture Combustion of wood products with energy capture as the carbon is emitted to the 

atmosphere (alternatively called Energy).

NoCapture Carbon in harvested wood emitted to the atmosphere through combustion or 
decay without energy recapture (also called Emissions).

A 10 Year Report (Fig. 6) at the bottom of the page shows carbon storage calculations in 10-year 
increments, so you can see how carbon storage changes over time for each of the five storage categories.

Figure 6.—Screen capture of 10 Year carbon report. This report provides the 
values for the hardwood pulpwood carbon pools at 10-year intervals.

You can sort the values in the table by Year. To do this, click on any column header. Successive clicks 
toggle the sort between ascending (Year 0-100) and descending (Year 100-0) order.

Editing Input Values
If you need to change any of the stand details you entered, you can do so by clicking on the Edit 
button at the top of the Stand Details page. When you have finished making your changes, click 
Save again. PRESTO will recalculate carbon storage based on your updated input and redisplay your 
results.

You can also edit your input from the Review page.
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Upload Batch

Use the Upload Batch option (Fig. 7) to simultaneously enter information for multiple stands. Click 
on the Upload Batch tab to open the Stand Batch Upload page.

Using the Upload Template—Manual Data Entry
From the Stand Batch Upload page, download the Access template file by clicking on the PRESTO 
Batch Upload Template link. Save the file in a folder on your computer and then open it.

If necessary, enable all content in the database. Your copy of Access may be set to disable certain 
content for security reasons. You will need to enable this content to use the template. In Access 2007, 
do this by clicking on the Options button in the Security Warning message bar, and then clicking 
on the Enable this content radio button in the Security Alert window. In Access 2010, click on the 
Enable Content button in the yellow Security Warning message bar to enable all content.

If you do not see an option to enable content, it is likely that your copy of Access is set to block active 
content without providing you with notification. You will need to change this security setting in 
order to enable the content in the template. Close the template and follow the steps outlined below 
for your version of Access.

Figure 7.—Screen capture of Batch Upload page. The batch upload allows data from multiple stands to be 
loaded into PRESTO at one time. Batch upload is available for both the Lump sum and Wood type data 
entry methods.
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To change security settings in Access 2007:

1. Open MS Access.

2. Click on the Office button (upper left corner), and then click on the Access Options button 
at the bottom of the window.

3. Go to the Trust Center (bottom portion of the frame at left) and click on the Trust Center 
Settings button.

4. On the Trust Center window, click on Macro Settings in the frame at left.

5. Click on the Disable all macros with notification option.

6. Click OK and close Access.

7. Open the PRESTO Batch Upload Template and enable the active content by clicking on 
the Options button in the Security Warning message bar, and then clicking on the Enable 
this content radio button in the Security Alert window.

To change security settings in Access 2010:

1. Open MS Access.

2. Under the File menu, click on the Options button near the bottom of the frame at left.

3. Go to the Trust Center (bottom portion of the frame at left) and click on the Trust Center 
Settings button.

4. On the Trust Center window, click Macro Settings in the frame at left.

5. Click on the Disable with notification radio button.

6. Click OK and close Access.

7. Open the PRESTO Batch Upload Template and enable the active content by clicking on 
the Enable Content button in the yellow Security Warning message bar.

Once all content is enabled, you will see a blank form with a menu bar at the top, and a series of 
buttons across the bottom (Fig. 8).

Figure 8.—Screen capture 
of PRESTO Batch Upload 
Template. Select the button 
for the appropriate data 
entry method to activate 
the data entry form. If the 
buttons do not respond, 
follow the instructions to 
enable all macro content.
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Menus

File The only option under this menu is Exit, which closes the Access template. You can 
also exit the template by clicking on the Close and Exit button at the bottom of the 
form.

Edit This menu contains options that enable you to replicate records in the Lump sum and 
Wood type data forms, or Copy them from an Excel file and Paste Append them into 
the data forms.

Help Click on the About option to see information about the Access template; click on the 
Help option for guidance on how to use the template.

Buttons

Info Click on this button to open the form that provides information about the 
Access template (the same form that can be accessed from Help | About).

Import Lump Sum Click on this button to open the data form required to enter stands for 
which you know the percentage of sawlogs and pulpwood in the harvest.

Import Wood Type Click on this button to open the data form required to enter stands for 
which you know the actual volume harvested for sawlogs and pulpwood.

Review Click on this button to open a form that provides a read-only display of 
the data you entered.

Close and Exit Close the Access template by clicking on this button, or by choosing Exit 
from the File menu.

To manually populate a Batch Upload Template:

1. Click on the Import Lump Sum button to enter stands for which you know the 
percentage of sawlogs and pulpwood in the harvest.

2. Enter information about your stands into the fields of the Batch Upload – Lump 
Sum data form. No fields in this form can be left blank. When there is no harvest for a 
particular wood type, enter a zero and select any units. Use the tab key on your keyboard 
to move from one cell to the next, until you have entered data into every field.

3. When done, click on the Validate button to ensure that your data will upload into the 
Access template without errors. If the data you entered violate any of the validation rules 
(such as missing values), an error message will appear directing you to correct the error 
or cancel data entry. When validation is successful, the data you entered will be imported 
into the template database, and summary information for each stand will be displayed on 
the Batch Upload Template form.

4. Click on the Import Wood Type button at the bottom of the template to enter stands for 
which you know the actual volume harvested for sawlogs and pulpwood.
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5. Repeat steps 2 and 3 to enter your remaining stands. In the example below (Fig. 9), stands 
have been entered using both calculation modes.

Figure 9.—Screen shot of Batch Upload Template records. This screen lists all records that 
were uploaded and allows the user to select and review records.

6. You can review the data you entered for any stand by selecting the record for that stand on 
the Batch Upload Template (left-click to highlight it) and then clicking on the Review 
button at the bottom of the form. The Review form (Fig. 10) is read-only; you cannot make 
changes here to the data you entered.

7. Click Delete if you wish to remove the selected record from the template database, or Close 
to return to the Batch Upload Template.

8. When done, click on the Close and Exit button (or select Exit from the File menu) to close 
the Access template.

Figure 10.—Screen shot of Batch Upload record review form. Note that data may not be edited 
from within this form.
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Using the Upload Template—Copy and Paste Append
You can also enter information into the Batch Upload Template from an Excel spreadsheet by using 
the Edit | Copy and Edit | Paste Append options in the Lump sum and Wood type data forms. The 
fields in your Excel spreadsheet must be in the same order as the fields in the data forms, and your 
data must comply with the validation rules in the Access template; be sure to use the same Region 
abbreviations and Units as in the drop-down lists.

To assist with the process of importing data from Excel into the Access template, a Template Helper 
has been provided. This is an Excel file that contains the required fields in the required order for each 
calculation mode, and drop-down lists for Region and Units. Download the file from the Stand 
Batch Upload page by clicking on the Template Helper link (Fig. 11).

Save the file in a folder on your computer. Open the file and enter your data.

To populate an Access data form by using Copy and Paste Append:

1. With the Access Batch Upload Template open, open the Lump Sum data form (Import 
Lump Sum button) to enter stands for which you know the percentage of sawlogs and 
pulpwood in the harvest.

Figure 11.—Screen shot of the Stand Batch Upload page showing the location of the Template Helper 
link. Use of this spreadsheet will ensure that data are formatted correctly for upload.
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2. Open the Excel worksheet that contains your lump sum data; select only the data (not the 
field headings) and copy (Ctrl-C or use the copy option in Excel) to place the data on your 
clipboard.

3. Toggle over to the Batch Upload - Lump Sum Access data form and click in the first cell of 
the first empty row.

4. From the Edit menu, select Paste Append.

5. If you encounter a paste error, you may be missing a value in a required field (bold column 
names in the Template Helper). You can see the number of records that were NOT added 
to the template by clicking on the Paste Errors button in the bottom left corner of the data 
form. Review your data, ensuring all required fields are fully populated, and try again.

6. Repeat steps 1 through 5 to copy and paste append your wood type data.

The Edit | Copy option on the Lump Sum and Wood Type data forms can also be used to replicate 
records already in the template.

To replicate stand data already in a Lump Sum or Wood Type data form:

1. With your Access data form open (for example, Lump Sum), select the records you wish to 
replicate (left-click and drag to select multiple contiguous records; the form will not allow 
you to select noncontiguous records).

2. From the Edit menu, select Copy and then select Paste Append.

3. The selected records will be appended to the existing records in the data form.

4. Edit the values as needed and then click Validate to upload the records into the PRESTO 
Batch Upload Template.

5. When done, click Close and Exit to close Access and return to the Stand Batch Upload 
page in PRESTO.

Note to users with Access 2013:

The Paste Append command may not appear under the Edit menu, but may be located on the Add 
Ins menu. Click in the first cell of the batch upload data form to activate it and select Add Ins | Paste 
Append from the menu bar. If the command is not active, you may access this function by adding 
the Paste Append button to your Quick Access Toolbar. Select the drop-down arrow on the Quick 
Access Toolbar and select Customize Quick Access Toolbar | More Commands. Choose Paste 
Append from the list of Popular Commands, and click on the Add button to add the function to 
your toolbar.

Uploading Batch Data into the PRESTO Database
When you have successfully entered your data into the PRESTO Batch Upload Template, the next 
step is to upload those data into the PRESTO database.
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To upload data into the PRESTO database:

1. From the Stand Batch Upload page (Fig. 12) in PRESTO, click on the Browse button.

2. Navigate to the PRESTO Batch Upload Template file you just populated, click on it to 
select it, then click Open. The File Upload window will close, and you will see the name of 
the file you just selected displayed beside the Browse button on the Stand Batch Upload 
page.

3. Click on the Upload button to start the batch upload. A status bar will show the progress of 
the upload. Uploading stand information from the Access template into PRESTO includes 
the process of carbon calculation for each stand (you can see the results of those calculations 
by clicking on the Review tab).

Figure 12.—Screen shot showing the location of the Browse button on the Stand Batch Upload page.
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4. When the upload is completed, PRESTO will display a Template Upload page (Fig. 13) 
that identifies the Import template file by name (note the automatically revised filename), 
provides an UploadID, confirms the number of stands imported, and lists the StandID 
numbers for each uploaded stand.

5. On the Template Upload page, click on the UploadID to see a summary list of the stands 
contained in the upload. For each stand, the StandID, Stand Name, Calculation Mode, the 
Added On date, and the username of the person it was AddedBy (your username) will be 
displayed. Use the Back button of your browser to return to the Template Upload page.

6. You can also view the stand details for each of the uploaded stands. To do this, click on a 
hyperlinked StandID to open a Stand Details page for the selected stand. Use the Back 
button of your browser to return to the Template Upload page if you wish to view the 
details of another stand. Alternatively, you can view details for any stand you have entered 
from the Review tab on the PRESTO menu bar.

Figure 13.—Screen shot of Template Upload summary report. This report provides a list of the stands 
that were successfully uploaded into PRESTO.
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At any time, you can review all of the uploads you have made. To do this, click on the Upload Batch 
tab on the PRESTO menu bar to open the Stand Batch Upload page. From there, click on the View 
Uploads link (Fig. 14).

This action opens a page that displays a table listing all of the template files you have uploaded into 
the PRESTO database. Each upload has a unique numerical identifier. Click on a hyperlinked ID 
to see a summary of the data uploaded from the corresponding template file. Use the Back button of 
your browser to return to the table.

Figure 14.—Screen shot showing the location of the View Uploads link on the Stand Batch Upload 
page.
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Review

Click on the Review tab to open the Review Stands page. This page displays the full list of stands 
you have entered, and shows the results of carbon calculations. From this page, you can add a new 
stand, delete one or more stands, edit stands, filter your list of stands, sort your list of stands by any 
of the parameter headings, change the number of stands displayed per page, and export the carbon 
calculations for some or all of your stands to an Excel spreadsheet.

Add a New Stand
To add a new stand, click on the[  ] Add new item hyperlink in the upper left corner of the form 
(Fig. 15).

Figure 15.—Screen shot of the Review Stands page showing the location of the Add New Item option. 
This link may be used to add additional stands, if needed.

This action opens the Stand Details form; enter your stand information as described above for 
Entering Stand Details.
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Delete a Stand
To delete a stand, click on the red Delete marker (Fig. 16) beside the stand you wish to remove. All 
information about deleted stands, including carbon calculations, is removed from the PRESTO database.

Figure 16.—Screen shot of Review Stands page showing the location of the Delete Item button. 
This option may be used to delete the data for a particular stand.

Filter the List of Stands
You can filter your list of stands on the Review Stands page (Fig. 17) by region. Open the Region 
drop-down list and select a region; only the stands from that region will be displayed. All stands in 
your list will be filtered, not just the ones you have displayed (if less than – All –).

Figure 17.—Screen shot of Review Stands page showing the location of the Filter by Region drop-
down menu. If working with data from a variety of regions, you may use this option to display only 
those stands in the selected region.

Edit Stands
You can edit any stand in your list by clicking on the hyperlinked stand ID value. This action opens the 
Stand Details page where you can make your edits as described above in Editing Input Values. When 
you save your work, PRESTO will recalculate the carbon storage values based on your revised input.
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Sort the List of Stands
Sort your list of stands by clicking on one of the parameter headings. For example, to sort by Area, 
click on the Area heading. Successive clicks will toggle the sort between ascending and descending 
order. All stands in your list will be sorted, not just the ones you have displayed (if less than – All –).

Change the Number of Stands to Display
You can change the number of stands displayed per page on the Review Stands page (Fig. 18). For 
example, if you have entered more than 10 stands and wish to see them all on a single page, select the 
next largest value (or – All –) from the Items Per Page drop-down list.

Figure 18.—Screen shot of the drop-down 
menu used to select the number of records 
to display on the Review Stands page.

Export Calculations to Excel
You can export the stand details, including carbon calculations, for some or all of the stands you 
entered to an Excel spreadsheet.

To export carbon calculations to Excel:

1. From the Review Stands page, click on the Excel icon [ ] at the bottom of the list of stands.

2. Name the file and save it to a folder on your computer, then open it.

3. All information (except stand ID) about all of the stands listed on the Review Stands page 
will be exported to Excel (Fig. 19).

Figure 19.—Screen shot of Excel spreadsheet created by using the Export Stands to Excel option on the Review Stands page.

4. You can also export information only for stands in a particular region. To do this, filter your 
list of stands by the region you want, and then click on the Excel icon to export. Only the 
filtered records will be exported.
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QUESTIONS AND ANSWERS

Why are there different ways to enter data? When would I use “Lump Sum”?

Data may be entered into PRESTO in several ways, depending on your objectives. Lump sum data 
entry is an “exploring” mode and does not require detailed harvest volumes. One of the issues that 
managers and landowners often want to understand is the effect of changing rotation length, which 
changes the product mix. Using lump sum data entry, you can quickly assess the differences in 
stored carbon over time with varying amounts of pulpwood and sawtimber. The wood type entry is 
appropriate when you know your harvested volumes of pulpwood and sawtimber and are working 
with just a few stands. For users with multiple harvests and stands, using the batch upload template 
will eliminate the need to enter each stand individually.

How does PRESTO calculate carbon from harvest volume?

PRESTO is based on the methods and ratios that were developed to support the 1605b program 
of voluntary greenhouse gas reporting; these methods are consistent with the IPCC guidance on 
harvested wood products. For a detailed explanation, see Smith and others (2006).2

Why are there only categories of hardwood and softwood, and not individual species?

The ratios that PRESTO uses were developed as general ratios for each region, compiled from 
available data. Species-specific ratios were not developed as the available data sets would be too small 
to produce values that could be widely applied.

Does PRESTO have built-in error checking? What if I make a mistake when I enter my data?

PRESTO checks that the correct fields have been completed, but does not have an error-checking 
routine to flag extreme values. If you enter a harvest of 120,000,000 mbf of hardwood sawtimber 
per acre in the Lake States region, PRESTO will apply the correct coefficients to the data that you 
entered and return a result, even though such a harvest value does not make sense. Please enter data 
carefully, and if using the batch upload, check your spreadsheet for errors before loading your data 
into PRESTO. Always check your output to ensure that the carbon values returned are logical for 
a given harvest level. If they seem to be unreasonable, review your stand to ensure that the correct 
values and units were entered.

Why is there no option to select a bioenergy product, such as wood chips or pellets?

Although the methods to account for the amount of energy or heat units that could be produced 
from a given harvest value are straightforward, many other factors are involved in bioenergy 
calculations, and these are often the result of operational or policy parameters (for example, are 
the chips to fuel a cogeneration system or for direct production of electricity?). As such, bioenergy 
calculation is outside the scope of this tool.

2 Smith, J.E.; Heath, L.S.; Skog, K.E.; Birdsey, R.A. 2006. Methods for calculating forest ecosystem and 
harvested carbon with standard estimates for forest types of the United States. Gen. Tech. Rep. NE-343. 
Newtown Square, PA: U.S. Department of Agriculture, Forest Service, Northeastern Research Station. 216 p.
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How do I interpret and use the report? Why are there two types of reports, the 10-year and the 100-year 
average?
Carbon that may be considered to be stored is reported in the “Stored” column, and is the sum of 
the carbon in products in use and carbon in products in landfills. The amounts of carbon in the 
categories change over time, as products remain in use, are discarded to landfills, decay in landfills, 
are burned, etc. To estimate total carbon for a stand, you would add the value in the “Stored” 
column to your estimate of carbon in your stand (depending on the pools that you choose to 
inventory and estimate, this may be just live tree carbon, or may include other pools such as standing 
dead and down dead). The 10-year reports illustrate how the carbon in the different pools shifts and 
changes over time. The 100-year average represents the average carbon in that pool over a 100-year 
period, and is the metric used by the California Air Resources Board protocol. If you want to explore 
the effects of changing the mix of products between wood types and pulpwood and sawtimber, either 
report format may be used. In any case, the value in the “Stored” column is the variable to compare 
between harvest scenarios.

What about logging slash? Does PRESTO track the carbon harvested but not removed from the stand?
No, PRESTO deals only with the main stem and does not track slash. If you are interested in a 
more comprehensive carbon report, consider using the Forest Vegetation Simulator (FVS), which is 
a stand-level growth and yield modeling system that allows the user to simulate a variety of harvests 
and other management treatments. The Fire and Fuels Extension to FVS includes options for stand-
level carbon reports and harvested carbon reports. By using both reports, you can estimate carbon 
in a wide variety of pools, and manage logging slash in several ways. For more information on these 
reports, see Hoover and Rebain (2011)3. Note that FVS requires detailed data and is a complex 
model requiring a significant amount of time to learn.
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Carbon stored in harvested wood products is recognized under international carbon 
accounting protocols, and some crediting systems may permit the inclusion of harvested 
wood products when calculating carbon sequestration. For managers and landowners, 
however, estimating carbon stored in harvested wood products may be difficult. 
PRESTO (PRoduct EStimation Tool Online) is a Web-based tool that enables users 
to easily estimate the carbon stored in harvested wood products and the changes in 
this quantity over time. The tool may be used in an exploratory mode to examine the 
impacts of changing the amounts of longer- and shorter-lived products, or with specific 
harvest data to produce stand-level reports. The methods used are consistent with the 
Intergovernmental Panel on Climate Change (IPCC) Good Practice Guidance, as well as 
U.S. voluntary carbon accounting guidelines.

KEY WORDS: harvested wood products, carbon accounting, forest carbon, HWP carbon 
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